
XRay Physics 
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This lab investigates the production and absorption of Xrays. You will verify Moseley’s law 
and make measurements of the fine structure of the Klines of various elements. A cooled intrinsic 
germanium solidstate Xray detector is used to measure the spectra of Xrays under a variety of 
circumstances that illustrate several of the important phenomena of Xray physics. Phenomena 
observed and measured include the production of Xrays by fluorescent excitation, bremsstrahlung, 
and electronpositron annihilation and the absorption of Xrays by photoelectric interactions, Comp
ton scattering, and pair production. The energies of the K Xray lines of numerous elements are 
measured and compared with the predictions of Moseley’s Law. The energy separations and relative 
intensities of the Kα and Kβ lines are measured and compared with the theory of fine structure in 
the n=2 orbitals. 

1. PREPARATORY QUESTIONS 

1. What are the possible ways in which photons with 
energies in the range from 1 to 2000 keV can inter
act with matter? (see Reference [1] or similar). 

2. How does a germanium solidstate detector work? 
(see Reference [2] or similar). 

3. What atomic transitions give rise to the Xray lines 
labeled K − L3 (Kα1), K − L2 (Kα2) and K − M3 

(Kβ1) (see References [3, 4] or similar). 

4. According to the CRC Handbook [5], the total cross 
section of lead for interaction with 24.94 keV X rays 
is 48.2 cm2g−1 i.e. the total interaction cross sec
tion of all the atoms in 1 gram of lead is 48.2 cm2). 
By what factor would the intensity of a pencil beam 
of such X rays be reduced by passage through 0.01 
cm of lead? 

5. Plot a curve of the expected energy E of Kα Xrays 
against the atomic number Z . 

2. INTRODUCTION 

In 1895 Röntgen discovered that a high voltage dis
charge between electrodes in a gas at very low pressure 
produces a penetrating radiation which causes certain 
materials to fluoresce visible light [6]. He observed that 
if the voltage is sufficiently high, the radiation, which 
he called X rays, can penetrate a hand, casting shadows 
of the bones on a fluorescent screen. Within a month 
his discovery created a worldwide sensation. It soon 
came to be understood that electrons, emitted from the 
negative electrode (cathode) of the discharge tube, and 
accelerated by the applied voltage, emit electromagnetic 
radiation (bremsstrahlung X rays) when they collide with 
the positive electrode (anode) or the walls of the tube. 
Röntgen thought, tentatively and incorrectly, that the 
new rays were longitudinal electromagnetic waves. The 
highfrequency transverse wave nature of X rays was fi
nally proved sixteen years later by von Laue’s discovery 

of the diffraction of X rays by crystals. The significance 
of Röntgen’s discovery for medical diagnosis was quickly 
recognized. Kaisers, queens and lesser folk shared the 
wonder of gazing at the interior structure of living bodies 
without cutting them open. In the 1930’s children could 
spend hours at the shoe store amusing themselves by wig
gling their toes in the Xray fluoroscope used to judge the 
fit of new shoes. Millions had their chests regularly exam
ined by highdose Xray photography for signs of tubercu
losis. Since the 1940’s it has been known that irradiation 
of genetic material in cells by X rays and other ionizing 
radiations induces changes that can cause cancer. Expo
sures significantly exceeding that due to natural sources 
such as cosmic rays and background radioactivity must 
therefore be avoided. The sources used in the present ex
periment have been approved by the MIT radiation safety 
office for educational use. They are not dangerous if han
dled with appropriate caution. You are urged to deter
mine the exposures you may receive in various manipula
tions of the laboratory sources by making suitable mea
surements with the laboratory radiation exposure meter. 
The consequences of Röntgen’s discovery for physics were 
profound. Six years previously Hertz had discovered elec
tromagnetic radiation (gigahertz radio waves) with wave
lengths a million times longer than that of visible light. 
Röntgen’s work showed how to generate electromagnetic 
radiation with wavelengths ten thousand times shorter. 
Such wavelengths are comparable to atomic dimensions. 
As a consequence, X rays proved to be a powerful means 
for exploring the atomic structure of matter as well as the 
structure of atoms themselves. Over the next 30 years the 
discovery and measurement of Xray phenomena played 
a central role in the development of the modern quan
tum theory of matter and radiation. Among the most 
important landmarks were von Laue’s discovery of Xray 
diffraction by crystals, Moseley’s discovery of the rela
tion between atomic number and the wavelengths of the 
characteristic X rays emitted by the elements, Siegbahn’s 
studies in XRay spectroscopy [7] and Compton’s discov
ery of the quantum character of the scattering of X rays 
from free electrons [8–10]. In the present experiment you 
will use a germanium solidstate Xray spectrometer to 
study a variety of phenomena involving the interactions 
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of highenergy photons and matter. The introductory 
part is a study of Xray production by irradiation of mat
ter by electrons and Xrays. It is intended to familiarize 
you with the equipment and some of the basic physics of 
Xrays. The rest is a menu of possible studies you can 
pursue as time permits. 

The subdiscipline of XRay physics involves a certain 
amount of nomenclature and notation that you will need 
to become familiar with BEFORE performing this lab. 
A term diagram for the Xray levels of a heavy element, 
showing the transitions giving rise to the K, L, and M 
lines can be found in Reference [10] page 630 and also on 
the Junior Lab web site. This is necessary useful for read
ing some of the original literature on XRays. In more 
recent times, a more intuitive notation has become dom
inant (see Reference [3]) and you should become familiar 
with converting between both notations. 

TABLE I: Correspondence between Xray diagram levels and 
electron configurations. A more complete table can be found 
in [3] 

. 

Level Electron Level Electron Level Electron 

config. config. config. 

K 1s−1 N1 4s−1 O1 5s−1 

L1 2s−1 N2 4p−1 O2 5p−1 

L2 2p−1 N3 4p3/2
−1 O3 5p3/2

−1 

L3 2p3/2
−1 N4 4d3/2

−1 O4 5d3/2
−1 

M1 3s−1 N5 4d5/2
−1 O5 5d5/2

−1 

M2 3p−1 N6 4f5/2
−1 O6 5f5/2

−1 

M3 3p3/2
−1 N7 4f7/2

−1 O7 5f7/2
−1 

M4 3d3/2
−1 

M5 3d5/2
−1 

TABLE II: Correspondence between the Siegbahn (older) and 
IUPAC (newer) notations. A more complete table can be 
found in [3] 

. 

Siegbahn IUPAC Siegbahn IUPAC 

Kα1 K − L3 Lα1 L3 − M5 

Kα2 K − L2 Lα2 L3 − M4 

Kβ1 

Kβ2 
I 

K − M3 

K − N3 

Lβ1 

Lβ2 

L2 − M4 

L3 − N5 

Transitions between Xray levels are denoted by the 
level symbols for initial and final states separated by a 
hypen. The initial state is placed first, irrespective of 
the energetic ordering. Much of the older literature in 
this field uses the “Siegbahn” notation to describe X
ray transitions and Table II shows the correspondence 
between the two notations. As an example: K− L3 (Kα1 

in the Siegbahn notation) denotes the filling of a 1s hole 
by a 2p3/2 electron. 

3. EXPERIMENTAL ARRANGEMENT 

The detector is a solid state ionization chamber made 
of a single crystal of very pure germanium. The crystal is 
mounted behind a thin beryllium window in a vacuum on 
a copper “cold finger” which dips into liquid nitrogen con
tained in a large Dewar. This arrangement conducts heat 
away from the crystal and keeps the detector at a tem
perature of ≈80 K, which assures that the rate at which 
electrons are thermally excited into the conduction band 
of the crystal is very low. The crystal is reversebiased 
by ≈ 700 VDC in order to sweep out any conduction 
electrons that do appear, either as a result of rare ther
mal excitations or as a result of excitation by energetic 
charged particles such as the photoelectrons ejected from 
the germanium atoms by incident X rays. 

CAUTION – The field effect transistor in the 
preamplifier attached to the Ge detector is easily 
damaged and costly to replace. Please observe 
the following precautions: 

1. Be sure the preamplifier is powered (from the back 
of the NIM bin) before turning on the high voltage 
bias. 

2. SLOWLY raise the bias voltage to ∼ 700 VDC (be 
sure of the polarity!). 

3. Ask an instructor to oversee your first use of the 
system. 

An Xray photon can interact with the germanium 
crystal by: 

1. Photoelectric absorption by an atom, resulting in 
the disappearance of the photon and the creation 
of an excited ion through ejection from the atom of 
an electron with an amount of kinetic energy equal 
to the original energy of the photon less the energy 
(binding energy) required to remove the electron 
from the atom. 

2. Compton scattering by a loosely bound electron, 
resulting in a recoil electron and a scattered photon; 

3. Pair creation, if the energy of the incident photon 
is sufficient (hν > 2mec

2). The result is the disap
pearance of the photon and the materialization of 
an electron and positron with an amount of energy 
approximately equal to that of the incident photon 
less the rest energy of two electrons. 

4. Coherent scattering by the bound electrons of an 
atom, resulting in a scattered photon of slightly re
duced energy and changed direction, and negligible 
excitation of the crystal. 

Interaction of an incident photon by process 1,2, or 
3 is the start of a complex degradation process that in
volves multiple Coulomb interactions of the Compton
recoil, photoelectricejected, or paircreated electrons 
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FIG. 1: Qualitative term diagram from [11]. 

with atoms of the crystal, as well as interaction or es
cape of photons that may emerge from the interactions. 
The Coulomb interactions excite valence electrons into 
the conduction band, thereby giving rise to mobile charge 
that is swept by the bias voltage onto the emitter of the 
FET in the preamplifier. In the case of a primary pho
toelectric interaction, the excited ion, missing an inner
shell electron, decays by a cascade of transitions in which 
electrons from outer shells fall inward, terminating fi
nally with the capture of a stray electron into the va
lence shell. Each decay transition produces a photon 
of a certain characteristic energy which may interact in 
the crystal with the production of more recoil or photo
electrically ejected electrons. In pair production, if the 
positron comes to rest in the crystal it will combine with 
an electron and annihilate with the production of two 
511 Kev photons traveling in opposite directions. If all 
the energy of the original photon finally appears as the 
kinetic energy of secondary electrons in the crystal, then 
the amplitude of the resulting charge pulse will be accu
rately proportional to the energy of the incident photon; 
this is the ideal situation desired in Xray spectroscopy. 
On the other hand, if one or more of the secondary pho
tons escapes from the crystal, the resulting charge pulse 
will be smaller, resulting in a broadened spectral line or, 
more importantly, in a separate “escape” peak in the 
spectrum, corresponding to the escape of precisely one 
energetic photon such as the K Xray photon emitted by 

a germanium atom that has photoelectrically absorbed 
the incident photon. Figure 1 is a block diagram of the 
electronic equipment . The detector is connected through 
a preamplifier to an amplifier, and thence to a Perkin
Elmer/Ortec multichannel analyzer (MCA). The pream
plifier is permanently mounted on the detector. The am
plifier is a spectroscopy grade unit, with coarse gain vari
able in steps and a continuous fine gain control. The 
signal pulses from the preamplifier are positive. Positive 
pulses from the amplifier are fed directly to the ADC in
put of the MCA which takes 0 10 volt positive pulses 
with widths greater than 2 µs. (Use of the bipolar out
put assures that the baseline is restored after each pulse.) 
The MCA sorts the pulses according to their amplitudes 
and records the number of pulses in each of 2048 ampli
tude intervals. A histogram display of these numbers is 
generated by the MCA and represents the energy spec
trum of the detected X rays. 

Whenever you start up the system or make a change it 
is wise to check the proper function of the preamplifier, 
amplifier, and MCA by examining with an oscilloscope 
the pulses at the output of amplifier, and to check the 
overall performance of the system with the aid of the 
pulser. In particular, you should check that the shape 
and polarity of the pulses into each unit are correct, and 
that the amplitudes of the pulses you wish to analyze are 
in the proper range as they enter the MCA. The output 
current from the detector is accumulated on a small ca
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FIG. 2: Schematic diagram of the circuit arrangement for 
Xray spectroscopy. 

pacitor connected to the emitter of the input FET in the 
preamplifier. The capacitor is discharged automatically 
by an auxiliary circuit whenever the accumulated charge 
exceeds a certain limit. Each discharge produces a pulse 
of fixed height that appears in one or two channels of 
the MCA at the high energy end of the spectrum. The 
rate of these discharges varies according to the intensity 
of the radiation being measured. Care must be taken not 
to mistake the resulting spectrum feature for a line in the 
Xray spectrum being recorded. 

3.1. STARTING UP 

Turn on the NIMbin power supply, the PC, and the 
oscilloscope. Run the MCA control software called Genie 
2000 from the Windows desktop (details of the MCA 
software are contained in the appendix). Connect the 
amplifier output to the MCA and the oscilloscope. Turn 
on the high voltage supply and gradually apply the bias 
voltage of ≈ −700 volts while monitoring the detector 
output on the oscilloscope. 

Be sure you apply a negative bias voltage; a 
positive high voltage bias may damage the detec
tor. 

Place the 55Fe source a few inches in front of the Ge 
1detector window. (The window is made of beryllium 1000 

inch thick!. A guard has been placed over it to prevent 
accidental touching and breaking of the fragile foil, which 
must be as thin as possible to allow low energy X rays to 
be detected and yet strong enough to hold the vacuum.) 
Adjust the gain of the amplifier so that at its output the 
prominent 5.89 keV K − L line of 55Mn appears on the 
oscilloscope as a concentration of pulses with amplitudes 
near 1 volt . The amplifier should work with a coarse 
gain of about 300. Vary the distance between source and 
detector and note if the amplitude of the line begins to 
sag due to too high a counting rate. Back off sufficiently 
to insure a stable response. Accumulate a spectrum with 
the MCA, and adjust the gains so that the Mn K − L 
line is centered on the left side of the display. 

4. OBSERVATIONS 

1. The E versus Z relations (Moseley’s law) for the 
various series of characteristic K and L X rays (See 
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the original papers in References [12, 13]). 

2. The fine structure splittings of the K and L shell 
energy levels. 

3. Ratios of the maximum electron recoil energy to 
the incident photon energy for Compton scattering 
of photons. 

4. Attenuation	 cross sections of carbon, aluminum 
and lead for X rays of several different energies. 

5. The jump in absorption cross section at a K edge. 

Keep notes of the settings used in all your measure
ments so you can return to them quickly if desired. 

Analyze the spectra as you take them by using the cur
sor to determine peak position and the full width at half 
maximum (FWHM), and the region of interest (ROI) fea
ture to determine total counts and area under the peaks. 
Do not leave simple analysis of data for later. In partic
ular, where graphical display of the data is appropriate, 
have graph paper at hand and make a plot as you go 
along so that you can see what is happening. Record all 
pertinent information about each file in your notebook.. 

4.1. PRODUCTION OF ENERGETIC PHOTONS 

The purpose of the following experiments is to famil
iarize you with the various processes in which energetic 
photons in the energy range above several keV can be 
produced. The name “X ray” is generally given to such 
a photon if it is emitted by a free or bound electron and 
has an energy in the range from 0.1 to 100 keV. Below 
0.1 keV lies the “extreme ultraviolet”; above is the region 
of “gamma rays”. Photons emitted directly by nuclei are 
generally called gamma rays even if their energy is in 
the conventional Xray range. The highenergy photon 
production processes you will explore are: 

1. Bremsstrahlung (“Braking radiation”): An ener
getic electron which undergoes a sudden accelera
tion caused by interaction with a highZ nucleus has 
a high probability of emitting a “bremsstrahlung” 
photon with an energy in the range from 0 to the 
full kinetic energy of the electron. This is the pro
cess that occurred in Röntgen’s discovery experi
ment when electrons accelerated in the discharge 
struck the glass wall of the tube. 

2. Xray fluorescence induced by energetic 
charged particles: When an energetic electron 
or other charged particle (e.g.an alpha particle) in
teracts with an atom it may eject an electron from 
one of the inner shells. The resulting ion relaxes 
from its excited state by a cascade of transitions in 
which electrons from outer shells fall inward until 
no vacancy remains. Each transition gives rise to 
a photon with a characteristic energy. A photon 
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produced when an outer electron falls into a hole 
in the n=1,2, and 3 shells are called K, L, and M 
X rays, respectively. 

3. Xray fluorescence induced by X rays: A pho
ton with sufficient energy may interact with an 
atom to eject an electron from an inner shell in 
what is called a “photoelectric” absorption process. 
The subsequent relaxation of the excited ion pro
duces the same characteristic X rays as in electron 
bombardment. 

4. Emission of photons by the decay of excited 
nuclei: One example of this process is the decay 
of the excited nucleus of 57Fe created by the beta 
decay (K electron capture) of 57Co as described 
in Melissinos (2003). Under certain circumstances 
this decay yields photons with energies in an ex
tremely narrow range near 14.4 keV which can be 
exploited in ”Mössbauer” spectroscopy. In addi
tion, decay of the excited 57Fe electronic structure 
which results from the capture of the K electron 
gives rise to the characteristic Xray photons of 
iron. 

5. Annihilation of electronpositron pairs: Some 
unstable nuclei (e.g. 22Na) undergo a betadecay 
process in which a proton in the nucleus is trans
formed into a neutron with the emission of a 
positron (antielectron) and an electron neutrino 
according to the scheme 

p⇒ n + e + + νe (1) 

The ejected positron eventually interacts with an 
electron in the surrounding material and annihi
lates with the production of photons. Such anni
hilations usually yield two photons which, in the 
center of mass, travel in exactly opposite directions 
and each with an energy of precisely mec

2 in ac
cordance with the conservation of momentum and 
energy. 

5. EXPERIMENTAL PROCEDURE 

5.1. Production of bremsstrahlung and 
characteristic line radiation by highenergy electron 

bombardment of lead. 

The classic way to generate X rays is to bombard a 
metal target with a beam of energetic electrons. A typical 
commercial Xray generator, such as one used by a den
tist or in an airport baggage inspection system, employs a 
vacuum tube in which electrons, emitted from a filament
heated cathode, are accelerated by field supported by a 
highvoltage (50 keV) power supply, and strike a metal 
anode target. The spectrum of the X rays radiated from 

the target consists of a bremsstrahlung continuum with 
hcan energy cutoff at λ = V e (V is the voltage of the 

power supply), and narrow lines with wavelengths char
acteristic of the target material. In this experiment the 
source of energetic electrons is several millicuries of 90Sr 
which decays according to the scheme 

90Sr38 ⇒ 90 Y39 + e− + −νe 

90Y39 ⇒ 90 Zr40 + e− + −νe 

The source is contained in an aluminum and leadlined 
container (see Figure 2) which can be placed on the small 
wooden stand next to the detector so that the hole be
hind the lead shutter is aligned with the entrance window 
of the detector. CAUTION: Avoid exposing your 
hands to the radiation emerging from the hole in 
the lead lined box. The 90Sr source is quite strong 
(several millicuries) and the electrons which it 
emits readily bounce off lead nuclei in all direc
tions, including out through the hole. 

Observe the spectrum of pulses with nothing in the 
45◦ slot. Then put a thin (1/4“ thick) slab of lead in 
the 45◦ slot so that the beta particles (energetic elec
trons) emitted by the source strike the slab. Observe the 
spectrum of the pulses produced by the bremsstrahlung 
radiation from the lead target, and identify the charac
teristic XRays of lead. Using the K− L lines of lead and 
the 511 keV line from the 22Na calibration gammaray 
source as calibrators, determine the highenergy cutoff of 
the bremsstrahlung spectrum. How does it compare with 
the end point of the energy spectrum of the beta rays 
from 90Sr and 90Y (consult the CRC tables)? Replace 
the lead slab with other materials and observe their char
acteristic XRays. The 90Sr source is shielded in the lead 
container so as to confine the directions of its emissions 
to the target area. However, some scattered electrons 
emerge from the target along with the bremsstrahlung. 
You can estimate the electron contamination in the exit 
beam by measuring the change in the counting rate when 
thin ( 1 mm) layers of plastic are inserted between the 
window and the detector, or by deflecting the electrons 
with a strong permanent magnet. 

5.2. XRAY INDUCED FLUORESCENCE 

Measure the fluorescent radiation emitted by various 
target materials when they are irradiated by X rays from 
the 55Fe source. Arrange the geometry (see Figure 3) so 
that the target is as close as possible to the detector, but 
the X rays from the source can not enter the detector 
directly. Identify the features you see. (Note that 55Fe 
decays by Kelectron capture, leaving an excited 55Mn 
atom which decays by K Xray emission.) What is the 
lowest energy K line you are able to detect? The highest? 
What are the limiting factors? Put the Xray “howitzer” 
in front of the detector and dial an X ray. Inside the 
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howitzer is a strong source of gamma rays (241Am) and 
targets of various elements which can be placed in the flux 
of gamma rays by a turn of the knurled wheel. Record, 
measure and explain the resulting spectra, i.e. try to 
identify each line in each spectrum and explain its nature 
and origin. 

5.3. Emission of nuclear gamma rays and 
characteristic X rays by radioactive atoms 

Place the 133Ba gammaray calibration source in front 
of the detector window. Adjust the gain so that the en
ergy spectrum utilizes the full dynamic range of the MCA 
(2048 channels). Measure the spectrum and with the aid 
of Reference [4] identify as many of its features as you 
can. 

+5.4. e−e ANNIHILATION RADIATION 

Place the 22Na (yellow tip) gammaray calibration 
source near the Ge detector, turn the gain down by steps 
until the spectrum of pulses produced by photons with 
energies in the energy range from 0 to 1.5 MeV can be 
seen. Accumulate the spectrum until the statistical fluc
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tuations are well smoothed out. Identify the lines and 
explain their origins. Identify the continua of pulses 
produced by Compton scattering of the monoenergetic 
gamma rays in the Ge crystal; measure the energies of 
the Compton edges. Explain the relation between the en
ergies of the photopeaks and the Compton edges in terms 
of the theory of Compton scattering. 

Do the same with the 60Co source (blue tip). With suf
ficient statistics you may see a tiny blip in the spectrum 
near 0.511 MeV. How do you account for that? 

5.5. MOSELEY’S LAW 

The purpose of the following observations is to measure 
with precision the properties of the characteristic X rays 
emitted by various elements, and to understand in terms 
of the theory of atomic structure how the properties vary 
with Z. In particular, you will measure the relative en
ergies and relative intensities of the K and L Xrays as 
functions of atomic number. The analysis of the ener
gies will provide a check of Moseley’s law. The relative 
intensities and separations of the K − L3 and K − L2 

lines can be compared to the values expected from theo
retical considerations of the effect on energy levels of the 
spinorbit interactions of the Lshell electrons. Adjust 
the gain so that the K lines of lead are at the far right 
end of the MCA histogram and record their positions. 
The variable xray source used in this portion of the ex
periment (Amersham AMC.2084) is detailed in Figure 5. 
It’s emission is detailed in Table III. 

TABLE III: Xray energies produced by Amersham variable 
Xray source. From Data Sheet 11196. 

Target Energy (keV)a Photon yieldb 

Kα Kβ sec−1 sr−1 

Cu 8.04 8.91 2,500 

Rb 13.37 14.97 8,800 

Mo 17.44 19.63 24,000 

Ag 22.10 24.99 38,000 

Ba 32.06 36.55 46,000 

Tb 44.23 50.65 76,000 

aweighted mean energies 
bthe photon yield was determined using a high resolution Si(Li) 

Xray spectrometer; the photon output is highly collimated limiting 
emission to ∼0.5 steradians. 

Place the variable energy Xray source (see the spec
ification sheet taped to the wall next to the radioactive 
source storage cabinet) in front of the detector and record 
the channel numbers of the K lines of terbium (Tb), 
barium (Ba), silver (Ag), molybdenum (Mo), rubidium 
(Rb), and Copper (Cu). In each case, obtain about 
10,000 counts in the major peak and measure as pre
cisely as you can the peak position, the FWHM and the 
total count under every significant peak observed. You 
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FIG. 5: Diagram of the Amersham variable energy Xray 
source. The primary source is 10mCi of americium241 (τ 
= 433 yr), consisting of a ceramic active component in a 
welded stainless steel capsule, with integral tungsten allow 
rear shielding. The maximum surface does rate (excluding 
emission aperture where the dose rate will vary with the tar
get in use) is less than 0.1mR/h. The principal α energies 
from Am241 are 5.442 MeV(12.5%) and 5.484 MeV(85.2%). 
γ energies are 59.5keV (35.3%). Also emitted are some Np L 
Xrays with energies between 11.922.2keV. 

may see peaks from the americium gamma rays, neptu
nium Xrays, escape peaks, etc. Search for L lines at low 
energies for the higherZ elements. In each case, print the 
MCA display, documenting the run in your notebook. To 
simplify the analysis try to cover the total energy range 
of the various spectra with one setting of the gain. It 
is wise to run through the series quickly several times 
until you get the settings just right, and then take your 
final data. For the terbium spectrum, record the counts 
per channel over the K − L and K −M peak regions, 
including the wings of the peaks, so that you will be 
able to make a detailed analysis of the structures of the 
lines. To get data on lead and other highZ elements you 
can use the 90Sr bremsstrahlung generator with various 
materials placed in the bremsstrahlung beam. You can 
also excite fluorescent Xray emission from highZ ele
ments with the gamma rays from the calibration sources. 
To study fluorescent emission in lowZ elements, increase 
the gain to place the copper K lines at the right hand end 
of the display. Measure the spectrum of the 55Fe source 
and the spectra of various lowZ elements fluoresced by 
the 55Fe radiation. (See how low in Z you can go.) 

6. ANALYSIS 

Try to identify all the lines that you can see in the 
various spectra. The most prominent are probably the K 
lines. Others may be “escape peaks” (see above), L lines, 
or background radiation from radioactivity in the room. 
Moseley discovered that the wave numbers, ν = λ , of 
characteristic Xray lines emitted by the elements under 
electron bombardment are related to the atomic number, 
Z, by equations of the form 

√
ν = C(Z − σ) (2) 

He measured the wave numbers directly by Bragg re
flection spectrometry, using crystals with known lattice 
spacings. The energies are related to wave numbers by 
the Planck formula 

hc 
E = (3)

2πk 

where h is Planck’s constant, c is the speed of light, 
and k is measured in wavenumbers (cm−1). In terms of 
Xray energies the Moseley relation is 

√
E = C �(Z − σ) (4) 

Your data provide relative measures of the Xray photon 
energies in terms of channel numbers n of the peak posi
tions which are approximately proportional to energy. 

√
E ∝

√
n (5) 

The essential features of the Moseley law can therefore 
be revealed by a plot of the square root of the measured 
channel numbers against the atomic numbers of the emit
ting elements. Make such plots for the each distinct set 
of lines (K−L3, K−N3, L−M , etc.), and determine the 
values of Cnσ in each case. Try to describe a complete 
and practical set of experiments that would achieve a fun
damental calibration of the germanium spectrometer in 
terms of energy versus channel number. In the present 
situation, assume that E(22Na) = 511 keV, E(55Fe) = 
5.8 keV and that the multichannel analyzer has a very 
linear response in between these values. lacking the nec
essary equipment and time, you will have to “peek” at 
an established result in order to tie your measurements 
down to actual energies. 

1. Convert all your peak positions and FWHM mea
surements to energies in keV with estimated errors. 
Do this with the highest precision that your data 
justify, and compare your results with the values 
tabulated in the CRC handbook. Determine the 
energies of the Ge K lines from data on the identi
fied escape peaks. 
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2. Determine the ratios of the intensities of the Kα1 

and Kα2 lines and compare with the theoretical ex
pectations based on consideration of the statistical 
weights of the parent LIII and LII states (see Ref
erence [11]). 

3. According to an approximate treatment of the spin
orbit interaction (see Compton and Allison, p. 
606), the doublet separation in energy should vary 
with Z as (Z − σ)4. Compare this prediction with 
your data. 

4. (for theoretical hot shots) For the case of Tb, ver
ify that the magnitude of the spinorbit splitting is 
that given by perturbation theory. 

What quantum rule forbids the transition from L1 

to K. Given this fact, how could you determine ex
perimentally the value of the energy L1 level of Tb? 

6.1. ABSORPTION OF XRAYS 

Measure the absorption coefficient of X rays of several 
widely different energies in several metals of widely differ
ent atomic number Z by inserting thin sheets of the metal 
between various sources of monoenergetic X rays and the 
detector. (The Xray howitzer is a convenient source of 
monochromatic X rays with energies in the range from 
6 to about 60 keV. The gamma ray calibration sources 
provide monochromatic photons up to 1.3 MeV). A typ
ical measurement might be carried out as follows: Place 
the howitzer about 10 cm from the detector with the 
dial turned to Ag. Measure the rate of pulses in the Ag 
K − L and K − M lines using the facilities of the MCA. 
Place a copper (lead) foil of measured thickness between 
the source and the detector and as close to the source as 
possible. Measure the reduced rate. (A good choice of 
thickness is one that reduces the rate by a factor of about 
2). Repeat the measurement with a second and third foil. 
Plot the natural log of the rate against the thickness mea
sured in g cm−2. Check whether the data conform to the 
formula for exponential attenuation, namely 

I0e
−µxI(x) =	 (6) 

or 

I(x)
ln 

I0 
= −µx	 (7) 

where x is the thickness and µ is a constant called the 
mass attenuation coefficient. The thickness is related to 
the linear thickness t and the density ρ by 

x = ρt	 (8) 

Fit a straight line to the log plot and from the slope 
determine the mass attenuation coefficient and the atten
uation cross section. Repeat for each energy and each el
ement, and summarize your results in tabular and graph
ical form. What regularities do you perceive? (You may 
find loglog plots of cross section versus energy or Z use
ful). Using the Ag source in the howitzer, compare the 
absorption cross sections of cadmium and palladium for 
the K − L and K − M lines of silver. Can you explain 
the difference in light of the fact that cadmium and pal
ladium do not differ much in atomic number? You can 
observe a similar difference between the absorption cross 
sections of various metals with Z near 25 for X rays from 
the 55Fe source. 

6.2.	 RELATION OF KEDGE ABSORPTION TO 
KLINE EMISSION 

Place a lead sheet in the beam of electrons emitted by 
90Sr in the plastic box to produce a continuum spectrum 
of bremsstrahlung radiation. Insert a foil of molybdenum 
in the slot between the lead target and the detector. Ob
serve what goes on in the spectrum recorded by the de
tector in the range of energies around the K − L (Kα) 
line of molybdenum. Observe the K − L absorption line, 
and explain how its place in the spectrum is related to 
the K − L line. 

7. CHALLENGE 

1. Place a 133Cs calibration source (green) close to the 
detector window, reduce the amplifier gain so as to 
place the needlesharp 661.63 gammaray line near 
the righthand side of the MCA display (use full 
2048 channel display). Don’t be confused by the 
higher level reset pulse from the detector preamp. 
Accumulate the spectrum for about one hour. Mea
sure channel positions of all the features you can 
discern. Download the spectrum for later detailed 
analysis. Try to provide a physics explanation for 
each of the features, making good use of the data on 
gammaray and Xray energies in the CRC Hand
book. 

2. Do the same with the 133Ba calibration source 
(black). 

3. Determine the composition of the United States 
quarter. With the system calibrated by Xrays of 
known energy, try to determine the elemental com
position of the United States quarter coin by mea
suring the spectrum of its fluorescent Xrays 
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8.	 POSSIBLE TOPICS FOR ORAL EXAM 

1. Atomic structure and the explanation of the Mose
ley relation between “Kline” energies and atomic 
number Z. 

2. Compton scattering. 

3. The classical theory of Thomson scattering and the 
Thomson cross section of the electron  (e.g. Ref
erence [14]). 

[1] A. C. Melissinos and J. Napolitano, Experiments in Mod
ern Physics (Academic Press, 2003), chap. 8.2.5, pp. 312– 
315, passage of Electromagnetic Radiation through Mat
ter. 

[2] G. F. Knoll, Radiation Detection and Measurement 
(John Wiley & Sons, 2000), chap. 12, pp. 405–426, 3rd 
ed., germanium GammaRay Detectors. 

[3] IUPAC, Analytical Compendium  XRay Spectroscopy 
(International Union of Pure and Applied Chem
istry, 2003), chap. 10.3.4.8, http://www.iupac.org/ 

publications/analytical_compendium. 
[4] R. Deslattes, E. Kessler, P. Indelicato, L. de Billy, E. Lin

droth, J. Anton, J. Coursey, D. Schwab, K. Olsen, 
and R. Dragoset, XRay Transition Energies (Version 
1.0) (National Institute of Standards and Technology, 
Gaithersburg, MD, 2004), http://physics.nist.gov/ 
XrayTrans. 

[5] CRC Handbook of Chemistry and Physics (CRC Press, 
20032004), 84th ed., 

[6] W. C. Röntgen, Nobel Lecture (1901), http://www. 
nobel.se/index.html. 

[7] K. M. G. Siegbahn, Nobel Lecture (1924), http://www. 
nobel.se/index.html. 

[8] A. H. Compton, Nobel Lecture (1927), http://www. 
nobel.se/index.html. 

[9] A. Compton, The Physical Reveiw, Second Series 22 
(1923). 

[10] A. H. Compton and S. K. Allison, XRays in Theory and 
Experiment (D.Van Nostrand, NY, 1935), pp. 590–595, 
2nd ed., the Elementary Theory of XRay Spectra. 

[11] A. H. Compton and S. K. Allison, XRays in Theory and 
Experiment (D.Van Nostrand, NY, 1935), pp. 646–655, 
relative Intensities in XRay Spectra. 

[12] H.	 Moseley, Phil. Mag. 26, 1024 (1913), the High
Frequency Spectra of the Elements, Part I. 

[13] H. Moseley, Phil. Mag. 6, 27, 703 (1913), the High
Frequency Spectra of the Elements, Part II. 

[14] R. D. Evans, The Atomic Nucleus (Krieger, Fla, 1955), 
this massive book was written by an MIT professor for a 
2semester course in Nuclear Physics in 1955 and covers 
a great deal of material! 

[15] B.	 Rossi, High Energy Particles (PrenticeHall, New 
York, 1952), available to MIT students online . 

4. The bremsstrahlung	 spectrum  (e.g. Refer
ence [15]). 

5. Attenuation of an Xray beam in matter  (e.g. Ref
erence [14]). 

6. The	 theory of the lithiumdrifted germanium 
(GeLi) detector  (e.g. Reference [2]). 
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APPENDIX A: USING GENIE 2000 AND THE 
CANBERRA MULTIPORT II MCA 

To start the Gamma Acquisition and Analysis pro
gram, first click on the Windows XP Start Menu. A 
shortcut to the program should be listed in the menu, but 
if not, simply select Genie2000⇒Gamma Acquisition and 
Analysis. When the program loads, choose File⇒Open 
DataSource. You will be presented with an option to 
choose a source of data: either a saved spectrum file or, 
to acquire new data by opening a detector interface pre
pared using the MID Editor. Select (MP2 MCA1) and 
click Open. Click Start to begin acquisition. 

To calibrate the enery scale, first move the region of 
interest (ROI) cursors so that they surround one of the 
peaks Next choose Display⇒ROIs⇒Add ROI. Repeat 
this procedure for each peak you wish to include in the 
calibration. When all the peaks have a ROI around them, 
it is now possible to have the Genie 2000 software detect 
the channel number at which each peak is located. To do 
this select Analyze⇒PeakLocate⇒User Specified. This 
will produce a window allowing you to specify how Genie 
2000 will locate the peak. Use the MCA view option to 
have Genie 2000 use the currently selected ROIs for its 
analysis. It is also necessary to select the Generate Re
port button in order to see the results of the analysis in 
the Report Window. 

Note the channel number at which each of the peaks 
is centered, as well as your expected value of the energy 
at that peak, select Calibrate⇒Energy Only Calibration. 
A dialog will appear which will allow you to enter in the 
channel number for each peak, which the Peak Locate 
analysis produced, and it’s corresponding accepted en
ergy value. Enter in the values for each peak, hitting 
Accept after each one, until all have been entered, then 
click OK. The spectrum is now calibrated to these ener
gies. Additional calibration sources can be used to fur
ther refine the results. To print out the spectrum as dis
played by Genie 2000, go to Analyze⇒Reporting⇒Print 
Spectrum. 

1. Exporting data to Matlab 

The default file format for the Genie 2000 software 
is a .CNF CAM file which contains a multiline header, 
and channel counts in a table which is not immediately 
portable to Matlab. However, Genie 2000 allows for a 
save to a file type .TKA (Toolkit) which is a single col
umn with each row containing the value of the channel 
count for that channel corresponding to the row number. 
For example, if the MCA software is set up to read 16384 
channels, then the .TKA file will be a 16384x1 array. To 
use this data in Matlab, rename the .TKA file, for ex
ample data.TKA, to data.dat. Then from within Matlab 
type: 

>>load data; 
Matlab will then populate a variable called data of the 

form of a single column with one row for each channel. 
Then in order to plot this in Matlab, you will need to 
create a column with channel numbers. To do this in 
Matlab, simply type: 

>> x = (1 : 16384); 
Which will make a row containing elements ranging 

from 1 to 16384, increasing in increments of one. Next, 
type: 

>> x = x�; 
which will switch the row with the column. You will 

now have two variables of the same dimension, one with 
channel number, and one with the counts at each channel. 
Then to plot the spectrum type: 

>>plot(x,data) 

APPENDIX B: EQUIPMENT LIST 

Model Description Contact 

Canberra 71255E Ge(Li) XRay Detector canberra.com 

Canberra 7600 Cryostat canberra.com 

Canberra 1708P PreAmplifier canberra.com 

HP 54601A Oscilloscope agilent.com 

Ortec 428 HV Power Supply orteconline.com 

Ortec 472 Spectroscopy Amp. orteconline.com 

Ortec 4006 Minibin and Power Supply orteconline.com 

MIT Samples/Sources 


